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ABSTRACT 

 
Nowadays there are lots of oil accidents happening in the ocean and it makes huge impact 

on environment. Due to Sea accidents can further cause oil pollution. So the oil separator 

systems are necessary in such cases. Various oil separator systems are available currently 

all over. In oil separator systems belt is one of the most important components. Different 

types of belts are been in use in these systems. Performance and efficiency of these 

systems mainly depends on the type of belt & belt material use in the system. So it is 

necessary to study and analyze the performance of various types of belts in order to select 

proper belt for better performance. In this paper we are taking a review of various types of 

belt materials used, research work done on oil skimmers and their belt materials. In this 

project we use a transformer, gear motor, solar panel, battery, charge controller, pully, 

bearing, load cell, LCD Display, conveyor belt and many things. The main purpose if this 

system is separate oil from water with a conveyor belt.  

 

SL. Belt Type Time Collect Oil 

1. Basic Belt 1 Min 120 ml 

2 Min 230 ml 

3 Min 330 ml 

2. Snake Sandwich 1 Min 200 ml 

2 Min 380 ml 

3 Min 450 ml 

3. Long Belt 1 Min 300 ml 

2 Min 380 ml 

3 Min 460 ml 
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Conclusion: 

In this project, we enforced to highlight the function of oil skimmer, its various 

design aspects and performance. All the results of experimental studies indicate that 

slight design improvement of typical oil skimmers towards to include additional belt 

shaft and use of belt with steel material instead of rope; significantly improve the oil 

recovery efficiency and also its structure became simpler. Further extensive research 

& testing can improve the existing techniques and equipment to have better control 

for oil recovery exercise. 
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Introduction 

 
1.1 Introduction 

The basic objective of this project work is to develop oil skimmer. Oil is one of the most 

important energy draw material sources for synthetic polymer and chemicals worldwide. 

As long as oil is explored, transported, stored and used their will ether risk of spillage. Oil 

pollution, particularly of sea and navigable water, has exited more public concerned than 

other water or spilt materials. Oil pollution of the sea has steadily increased with the 

increase in oil consumption. The bulk this in flux is due to transportation related 

activities spill from tanker loading and unloading operations, pipeline rupture which may 

be due to industrial waste as leakage from engines, incorrect operations of valves and 

discharge of oily wastages. [4] 

 

 
Oil pollution of the shore in addition to the reduction of amenity, also affects marine, 

shore life and vegetation. Crude oil consists of different hydrocarbon that range from 

light gas to heavy solids. When oil is spilled on water, the physical and chemical 

properties of oil change progressively. Spilled oil has an undesirable taste and odor and 

causes severe environment damage on water fall, material life and affects tourism 

economy. The pollution increasing various sectors of the world. [5] 

 

 
Oil is one of the precious crude and being used in many routine application of human life. Since most of 

the oils are toxic so quite dangerous for alive when it comes to direct contact with them. During the 

years of recent decades, world has witnessed many oil spillage tragedies and subsequent damage to 

alive and environments. Many countries has made stringent safety norms for waste water disposal 

contained with oils mainly typically from petrochemical and process industries so that such industries 

are equipped with such kind of oil skimmers to separate the oils from disposal water. [6] 

 

1.2 Objectives 
We have some specific objectives for this project and they are pointed below: 

 To Design and   Fabrication of Belt Type Oil Skimmer. 

 To It will separate the oil from the water and measure the amount of oil. 

 To operate this system with solar and AC current supply. 

 To take necessary notes from the project for future improvements. 
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1.3 Methodology 

Our methodologies for the project: 

 
• Creating an idea for design and of Belt Type Oil Skimmer. And designing a 

block diagram & circuit diagram to know which components we need to 

construct it. 

• Collecting all the components and programming the micro-controller to control 

the whole system. 

• Setting up all the components in a PCB board & then soldering. Lastly, 

assembling all the blocks in a board and to run the system & for checking 

purposes. 

      1.4 Flow Chart 
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 1.5 Organization of The Projects   

 
This project book consists of five chapter. The first chapter contains the statement of the 

introduction, our background study for the project, Literature Review, objectives of the study 

in the project, Methodology and the project organization. Chapter two contains System design 

and simulation. Here we describe the design of this project, block diagram and circuit diagram, 

working principle, background and real project, details of component and instrument details of 

the whole project. Chapter three contains the Hardware implementation. Chapter four deals 

with the experiment result, calculation, advantages and application of this project. In the final 

chapter, we discuss about future scope and conclusion of our project. 
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Chapter 2 

Literature Review 

 
2.1 Introduction 

This chapter is arranged on Literature Review. Here's a look at some of last year's 

literature, like our project. By reading them, we can overcome the mistakes of the 

previous project and make a more effective project. 

 
2.2 Literature Review 

A M Najar and et al [1]; It is now common practice to use disc skimming systems to 

recover oil floating on the surface of water. However, the performance of these devices 

is dependent on a large number of parameters and is certainly not understood 

completely. This paper describes a fundamental study in which experimental techniques 

have been developed to enable the performance of model skimmers to be measured.[1] 

This has enabled the importance of the various parameters to be examined in a more 

systematic and detailed way than ever before. Based upon an improved understanding 

of the flow behavior inherent in the oil collection process, a number of enhanced disc 

skimming systems are discussed. Results are presented for these systems to show the 

capabilities of the new forms of disc skimmer when operated as oil recovery devices 

[2]. 

 
A H Hammoud et al [2]; Oil spill recovery by means of a rotating drum skimmer 

was investigated experimentally for a wide range of design and operating 

conditions. The effect of drum diameter, drum length, rotating speed, oil lm 

thickness, oil properties, and drum center height above the oil/water interface 

surface were analyzed with respect to oil recovery rate of the drum skimmer. 

Crude, diesel, SAE 10W and SAE 140W oils were used during this investigation. It 

was found that oil recovery rate increases with increasing drum diameter, drum 

length, drum center height above the oil/water interface, and oil slick thickness oil 

viscosity, and increases as oil density and surface tension decreases. The results 

revealed that the drum skimmer is an effective device for recovering spills of low 

viscosity oil, such as light crude oil, which is the type of oil involved in most 
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serious spills and pollutions of the sea. Furthermore, an empirical equation is 

proposed for predicting the oil recovery rate of the device. The equation can be 

applied to different oils, and gives good agreement with observed data [3]. 

 
Suraj Nair et al; [3] Recently in Mumbai, there occurred 2 cases of sever oil spill near 

sea shore affecting most of the aquatic life of the area. Also fishing and tourism were 

affected by this spillage. The environmental effects of such oil spills are not negligible 

as this is a global problem now days. Every year, there is 100 million US gallons of oil 

spill. This is equal to 100 large size gymnasium halls. The numbers though could not 

tell the actual harm caused to the environment by such oil spill as it is in numerous. So 

there is need of an effective way to clean this oil from the surface without actually 

wasting it. Now, in industries, to separate oil from other things like coolant and water, 

we use oil skimmers. There are various methods for this, of which disk type oil 

skimmer is one of the majorly used [3]. 

 
Tushar Pathare et al [4]; Aim of this project is to remove the oily effluent from the 

waste water. Pollution has created lot of problems in industries. By removing the oil 

from waste water, it becomes free of oil pollutions. Oil skimmers are commonly found 

in three types: weir, oleophilic and non-oleophilic. Oleophilic skimmers are 

distinguished not by their operation but by the component used to collect the oil (rope, 

disk, belt or drum). It can remove even a thin floating film of oil from the water. This is 

mainly due to the ―oleophilic material‖ used in the belt. A free floating endless belt oil 

skimmer was developed as means of recovering spilled oil from surface water. The 

skimmer utilizes a unique high efficiency belt which is driven by motor. By removing 

oil we can preprocess water for other use. This can avoid water wastage and control 

pollution due to oil spillage. In current world scenario most of the oil from the 

industries goes wasted into ponds, rivers and sea. So, national and international 

environmental norms are getting strict day by day. It is economical to manufacture a 

low-cost machine to meet these norms [4]. 

 
Suraj Burungale et al [5]; Aim of this project is to remove the oily effluent from 

waste water of sugar factory. A free-floating endless belt oil skimmer was developed as 

means of recovering spilled oil from surface water. The skimmer utilizes a unique high 
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efficiency belt which is driven by motor. By removing oil, we can preprocess water for 

other use. A free-floating endless belt oil skimmer was developed as means of 

recovering spilled oil from surface water. The skimmer utilizes a unique high efficiency 

belt which is driven by motor. By removing oil, we can preprocess water for other use. 

[5] 

 
Philip C. Lewan et al [1992] [6] had studied apparatus for removing oil from the 

surface of a liquid using an endless belt partially submerged in the liquid, the belt 

passes over a primary roller having a vertical axis and pressure rollers squeeze the belt 

on the primary roller removing oil from the belt which allows by gravity to a collection 

receptacle mounted upon a frame supporting the primary roller and its drive structure. 

The belt twists whereby its lower portion submerged in the liquid denes a reversing 

loop whose configurations maintained by a weight roller having a horizontal axis of 

rotation. 

 
Mamta Patel [2015] [7] had studied the function of oil skimmer, its various design 

aspects and performance. All the results of experimental studies indicate that slight 

design improvement of typical oil skimmers towards to include additional belt shaft 

and use of belt with steel material instead of rope; significantly improve the oil 

recovery efficiency and also its structure became simpler. As practical overview of 

different oil spillage cleanup method, this paper has illustrated several limitations of 

these methods and current oil spill technology. Further extensive research & testing can 

improve the existing techniques and equipment to have better control for oil recovery 

exercise. 

 
Prof. P.A. Patil et al [2017] [8] had concluded that the separation of oil is based on 

surface tension, specific gravity and viscosity. He studied the operation of oil skimmer 

on various positions of the belt like inclined, vertical, horizontal. Spills may occur from 

refined petroleum products. Off and on from there by products, and heavier fuels used 

by large water vessels such as bunker fuel, or the spill of any oily refuse or waste oil. 

Cleaning and full recovery of spilled oil is challenging and may takes weeks or months. 

Sometimes even years required to clean up. 
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2.3 Summary 

The above has been discussed in detail in the past few literatures which has given us a 

lot of motivation to do this project. 
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Chapter 3 

Hardware Implementation 
 

3.1 Introduction 

This Project has worked on two things, Hardware and Software. Hardware is the most 

visible part of any information system. Here our hardware is Transformer, Gear Motor, 

Solar Panel, Battery, Charge Controller Circuit, Pulley, Bearing, Conveyor Belt etc. 

Software, instructions that tell a computer what to do. Software comprises the entire set of 

programs, procedures, and routines associated with the operation of a computer system. 

Software helps to design circuit. One software is we use here. This is Proteus. Detailed 

description of the hardware and software are given below. 

 

 
Software 

 
 Arduino IDE 

 Easy EDA 

 
Hardware 

 
 Arduino Nano 

 Transformer 

 Gear Motor 

 Solar Panel 

 Battery 

 Charge Controller 

 Variable Resistor 

 Conveyor Belt 

 Load Cell 

 Transformer 

 Pulley Timing Belt 

 Bearing 

 Pulley 

 Switch 
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3.2 Arduino Nano 

Arduino is open-source electronics prototyping platform based on flexible, easy-to-use 

hardware and software. It's intended for artists, designers, hobbyists, and anyone interested in 

creating interactive objects or environments. Arduino can sense the environment by receiving 

input from a variety of sensors and can affect its surroundings by controlling Lights, motors, 

and other actuators. [9] 

 

 

Figure 3.1: Arduino Nano  

The micro-controller on the board is programmed using the Arduino programming language 

(based on Wiring) and the Arduino development environment (based on Processing). Arduino 

projects can be stand-alone or they can communicate with software on running on a computer 

(e.g. Flash, Processing, Maxims’). Arduino Nano is a surface mount breadboard embedded 

version with integrated USB. It is a small, complete, and breadboard friendly component. It 

has everything that Decimal/ Demilunes has (electrically) with more analog input pins and 

onboard +5V AREF jumper. Physically, it is missing power jack. The Nano can automatically 

sense and switch to the higher potential source of power. [10] 

 

Figure 3.2: Arduino Nano Schematic Diagram 
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Nano’s got the breadboard-ability of the Boarding and the Minibus with smaller footprint than 

either, so users have more breadboard space. It’s got a pin layout that works well with the Mini 

or the Basic Stamp (TX, RX, ATN, and GND on one top, power and ground on the other). This 

new version 3.0 comes with ATMEGA328 which offer more programming and data memory 

space. It has two layers. That make it easier to hack and more affordable. One of the best 

features of Arduino Nano is, it’s easy to use, compact and also small. 

 

  

 

 

 

 

Figure 3.3: How Arduino Nano looks like 

Specifications:  

 Micro-controller: Atmel ATmega328  

 Operating Voltage (logic level): 5 V  

 Input Voltage (recommended): 7-12 V  

 Input Voltage (limits): 6-20 V  

 Digital I/O Pins: 14 (of which 6 provide PWM output)  

 Analog Input Pins: 8  

 DC Current per I/O Pin: 40 mA  

 Flash Memory: 32 KB (of which 2KB used by boot loader)  

 SRAM : 2 KB  

 EEPROM: 1 KB  

 Clock Speed: 16 MHz  

 Dimensions: 0.70‖ x 1.70‖  

 

Features:  

 Automatic reset during program download  

 Power OK blue LED  

 Green (TX), red (RX) and orange (L) LED  

 Auto sensing/switching power input  

 Small mini-B USB for programming and serial monitor  
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 ICSP header for direct program download  

 Manual reset switch  

 

Microcontroller IC ATmega328p 

 

Figure 3.4: Micro-controller IC AT mega 328p 

 

The high-performance Microchip Pico Power 8-bit AVR RISC-based micro-controller 

combines 32KB ISP flash memory with read-while-write capabilities, 1024B EEPROM, 2KB 

SRAM, 23 general purpose I/O lines, 32 general purpose working registers, three flexible 

timer/counters with compare modes, internal and external interrupts, serial programmable 

USART, a byte-oriented 2-wire serial interface, SPI serial port, a 6-channel 10-bit A/D 

converter (8-channels in TQFP and QFN/MLF packages), programmable watchdog timer with 

internal oscillator, and five software selectable power saving modes. The device operates 

between 1.8-5.5 volts. By executing powerful instructions in a single clock cycle, the device 

achieves throughputs approaching 1 MIPS per MHz, balancing power consumption and 

processing speed. [11] 
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3.2 Solar Cell: 

These panels are designed with solar cells composed of semiconductor materials. The 

main function of Solar panels is to convert solar energy into DC electrical energy 

generally of 12V, which is further used for the rest of the circuit. 

 

 
Figure 3.5: Picture of solar sell system. 
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The number of cells required and their size depends on the rating of the load. The 

collection of solar cells can produce maximum electricity. But the solar panel 

must place exactly at right angles to the sun rays. 

 
Certain materials can be made to produce electricity when light falls on them; this is 

called the photovoltaic effect. Solar panels use this effect to convert energy from 

sunlight into direct current (DC) electrical energy. An inverter unit then changes this 

into alternating current (AC) for your home's electrical circuits. Any excess energy can 

be fed back to the electricity grid, for which you may be paid an agreed feed-in tariff, 

or it could be fed into a battery storage system so you can use the stored power later 

(at night, for instance). 

Solar panels work best when they're north facing, pointed directly at the sun, at an 

optimal angle and not blocked by trees or shading. The effectiveness of solar panels 

also depends on where you live and the weather. A solar cell is a solid-state electrical 

device (p-n junction) that converts the energy of light directly into electricity (DC) 

using the photovoltaic effect. The process of conversion first requires a material which 

absorbs the solar energy (photon), and then raises an electron to a higher energy state, 

and then the flow of this high-energy electron to an external circuit. Silicon is one such 

material that uses such process. 

 

 

 

Figure 3.6: Solar sell system Curve. 
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Figure 3.7: Solar sell system Curve. 

 

3.3 Solar Charger Controller 

Here is a solar charger circuit that is used to charge Lead Acid or Ni-Cd batteries using 

the solar energy power. The circuit harvests solar energy to charge a 6-volt 4.5 Ah 

rechargeable battery for various applications. The charger has voltage and current 

regulation and over voltage cut-off facilities. 

 
 

Figure: 3. 8 Solar Charger Controller Circuit. 

 

 
The circuit uses a 12-volt solar panel and a variable voltage regulator IC LM 317. The 

solar panel consists of solar cells each rated at 1.2 volts. 12-volt DC is available from 

the panel to charge the battery. Charging current passes through D1 to the voltage 

regulator IC LM 317. By adjusting its Adjust pin, output voltage and current can be 

regulated. VR is placed between the adjust pin and ground to provide an output 

voltage of 9 volts to the battery. Resistor R3 Restrict the charging current and diode 
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D2 prevents discharge of current from the battery. Transistor T1 and Zener diode ZD 

act as a cutoff switch when the battery is full. Normally T1 is off and battery gets 

charging current. When the terminal voltage of the battery rises above 6.8 volts, Zener 

conducts and provides base current to T1. It then turns on grounding the output 

of LM317 to stop charging. 

 

3.4 Transistor: 

 
BC 547 NPN transistor Specifications: 

BIPOLAR TRANSISTOR, NPN, 45V, TO-92 

 Transistor Polarity: NPN 

 Collector Emitter Voltage V(br)ceo: 45V 

 

 Transition Frequency Type ft: 300MHz 

 Power Dissipation Pd: 625mW 

 DC Collector Current: 100mA 

 DC Current Gain hFE: 150 

 

The invention of the bipolar transistor in 1948 ushered in a revolution in electronics. 

Technical feats previously requiring relatively large, mechanically fragile, power- 

hungry vacuum tubes were suddenly achievable with tiny, mechanically rugged, 

power-thrifty specks of crystalline silicon. This revolution made possible the design 

and manufacture of lightweight, inexpensive electronic devices that we now take for 

granted. Understanding how transistors function is of paramount importance to anyone 

interested in understanding modern electronics. 

 

 
Figure 3.9: Transistor BC 547. 
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Figure 3.10: Transistor Symbol. 

 

My intent here is to focus as exclusively as possible on the practical function and 

application of bipolar transistors, rather than to explore the quantum world of 

semiconductor theory. Discussions of holes and electrons are better left to another 

chapter in my opinion. Here I want to explore how to use these components, not 

analyze their intimate internal details. I don’t mean to downplay the importance of 

understanding semiconductor physics, but sometimes an intense focus on solid-state 

physics detracts from understanding these devices’ functions on a component level. In 

taking this approach, however, I assume that the reader possesses a certain minimum 

knowledge of semiconductors: the difference between ―P‖ and ―N‖ doped 

semiconductors, the functional characteristics of a PN (diode) junction, and the 

meanings of the terms ―reverse biased‖ and ―forward biased.‖ If these concepts are 

unclear to you, it is best to refer to earlier chapters in this book before proceeding with 

this one. 

 
A bipolar transistor consists of a three-layer ―sandwich‖ of doped (extrinsic) 

semiconductor materials, either P-N-P in Figure below a(b) or N-P-N at (d). Each layer 

forming the transistor has a specific name, and each layer is provided with a wire 

contact for connection to a circuit. 

 
BJT transistor: 

(a) PNP schematic symbol, 

(b) physical layout 

(c) NPN symbol, 

(d) layout. 
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The functional difference between a PNP transistor and an NPN transistor is the proper 

biasing (polarity) of the junctions when operating. For any given state of operation, the 

current directions and voltage polarities for each kind of transistor are exactly opposite 

each other. 

 
Bipolar transistors work as current-controlled current regulators. In other words, 

transistors restrict the amount of current passed according to a smaller, controlling 

current. The main current that is controlled goes from collector to emitter, or from 

emitter to collector, depending on the type of transistor it is (PNP or NPN, 

respectively). The small current that controls the main current goes from base to 

emitter, or from emitter to base, once again depending on the kind of transistor it is 

(PNP or NPN, respectively). According to the standards of semiconductor symbology, 

the arrow always points against the direction of electron flow. (Figure below) 

 
 

 

Figure: 3.11 NPN & PNP Transistor Symbol. 

 
 

Small Base-Emitter current controls large Collector-Emitter current flowing against 

emitter arrow. Bipolar transistors are called bipolar because the main flow of electrons 

through them takes place in two types of semiconductor material: P and N, as the main 

current go from emitter to collector (or vice versa). In other words, two types of charge 

carriers—electrons and holes—comprise this main current through the transistor. 

 
As you can see, the controlling current and the controlled current always mesh 

together through the emitter wire, and their electrons always flow against the direction 

of the transistor’s arrow. This is the first and foremost rule in the use of transistors: all 
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currents must be going in the proper directions for the device to work as a current 

regulator. The small, controlling current is usually referred to simply as the base 

current because it is the only current that goes through the base wire of the transistor. 

 
Conversely, the large, controlled current is referred to as the collector current because 

it is the only current that goes through the collector wire. The emitter current is the 

sum of the base and collector currents, in compliance with Kirchhoff’s Current Law. 

No current through the base of the transistor, shuts it off like an open switch and 

prevents current through the collector. A base current, turns the transistor on like a 

closed switch and allows a proportional amount of current through the collector. 

Collector current is primarily limited by the base current, regardless of the amount of 

voltage available to push it. 

 
 

3.5 Transformer 

A transformer is an electrical device used to change the value of an alternating voltage. 

Transformers are widely used in electrical work. They are encountered daily, in industrial, 

commercial and domestic situations. They vary in size from miniature units used in 

electronics to huge units used in power stations. The efficient transmission and distribution 

of electricity throughout the country would be impossible without the use of power 

transformers. 

 
Transformers are also used for safety reasons on construction sites when using power tools 

and in domestic bathroom situations in shaver units. They are used in doorbell operation 

and also to power electronic equipment, battery chargers, televisions, computers, alarm 

systems, etc. Transformers vary considerably in construction, size and shape depending on 

their application. 

All transformers rely on the principle of mutual inductance for their operation. Mutual 

inductance was discussed in detail in Unit 2.1.6 Magnetism, Electromagnetism and 

Electromagnetic Induction. 
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Transformer Symbols: 
 
 

 

Figure 3.12: Transformer Symbols 

 

 

 

 
Transformer Construction: 

A transformer consists of two coils of wire called windings, which are wound onto a 

common iron core. The wire used in the two windings, primary and secondary, is coated 

with an insulating varnish. Both coils are wound onto, but insulated from the iron core. 

 
 

 

Figure 3.13: Transformer Construction. 

 

 

 

 

The Transformer Principle: 

When a conductor or coil is moved in a stationary magnetic field it cuts the lines of 

magnetic flux and an EMF is induced in the conductor or coil. This same principle also 

applies when a conductor is held stationary and the magnetic flux is made to change or 

vary. 

 
 

Now consider an alternating current applied to a stationary coil. A magnetic field will 

build up and collapse in the coil, continually rising and falling in harmony with the 

applied AC current as shown in Figure 2.2.8.3. 
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AC Supply 

Alternating flux 
continually 
building up, 
collapsing 

and changing 

in polarity 

 

Figure 3.14: Transformer Primary Coil. 

 

 
 

If a second coil (coil 2) is placed close to the first coil (coil 1) the alternating magnetic 

flux in coil 1 links with coil 2. This results in an EMF being induced in coil 2. This is a 

process known as mutual induction. 

 

Coil 1 Coil 2 

 

 

Applied Alternating 
Current Supply 

Alternating Induced 
EMF 

 
 
 

 

Figure 3.15: Transformer Primary & secondary Coil. 

 

 
 

If coil 1 and coil 2 are mounted on an iron core the magnetic flux around both coils will 

be concentrated. This arrangement of coils and an iron core form the complete device 

known as a transformer. 

 
 

Primary Winding Secondary Winding 

 
 

Applied Alternating 
Current Supply 

Alternating Induced 
EMF 

 
 

Lines of Flux set up by Primary Winding 

 

 

Figure 3.16: Lines of Flux set up by primary Winding 
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The input coil of a transformer is fed from the AC supply and is called the primary 

winding. The output coil, to which the load is connected, is called the secondary 

winding. 

It is important to remember that there is no electrical connection between the primary 

winding and the secondary winding of a transformer. The only common link between the 

two winding is the magnetic field. 

 
 

3.6 The Full Wave Rectifier: 

The first building block in the dc power supply is the full wave rectifier. The purpose of 

the full wave rectifier (FWR) is to create a rectified ac output from a sinusoidal ac input 

signal. It does this by using the nonlinear conductivity characteristics of diodes to direct 

the path of the current. 
 

 

Figure 3.17: Common four-diode bridge configuration for the FWR. 

 

 
 

Filtered Full Wave Rectifier 

The filtered full wave rectifier is created from the FWR by adding a capacitor across the 

output. 

 

 
Figure 3.18: Filtered full wave rectifier 
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The result of the addition of a capacitor is a smoothing of the FWR output. The output is 

now a pulsating dc, with a peak-to-peak variation called ripple. The magnitude of the 

ripple depends on the input voltage magnitude and frequency, the filter capacitance, and 

the load resistance. 

 
To describe the source of the voltage ripple, consider the performance of the filtered full 

wave rectifier above. The input to the rectifier is a sine wave of frequency f. Let Vi be the 

full wave rectified signal input to the filter stage of the rectifier and Vo be the output. Vi 

can be approximated as the absolute value of the rectifier input, with frequency 2f. 

 

 
Figure 3.19 Output (Vi) and input (Vo) of a filtered full wave rectifier 

 

 
 

In the time period from T0 to T1, the diode D1 (or D3, depending on the phase of the signal) is forward 

biased since Vi > VC1 (approximate the forward biased diode as a short circuit). The capacitor C1 charges 

and the voltage across the load R increases. From T1 to T2, the diodes D1 and D2 are reverse biased (open 

circuit) because Vcap > Vi, and the capacitor discharges through the load R with a time constant of RC 

seconds. [16] 

 

 

 
3.7 12v Battery 

A twelve-volt battery has six single cells in series producing a fully charged output voltage of 12.6 

volts. A battery cell consists of two lead plates a positive plate covered with a paste of lead dioxide and 

a negative made of sponge lead, with an insulating material (separator) in between. [17] 
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Quick Details 

 Brand Name: DOUBLE TECH (rechargeable 12v dc battery pack) 

 Model Number: DBG12-200(12V 200AH) 

 Nominal Capacity: 200AH 

 Place of Origin: Fujian, China 

 Weight: 57kgs 

 Certification: ISO9001 CE, MSDS 

 rechargeable 12v dc battery pack: 1PCS/CTN (according to the 

actual situation) 

 Production Capacity: rechargeable 12v dc battery pack:50000PCS/Month 
 

 

 

 

Figure 3.20: 12V Battery 

 

 

 

 

3.8 DC Gear Motor 

Description: 

A DC motor is any motor within a class of electrical machines whereby direct current 

electrical power is converted into mechanical power. A 12v DC motor is small and 

inexpensive, yet powerful enough to be used for many applications.[18] 
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Specification: 

• Voltage:12V DC 

• Gear ratio: 1/31 

• No-load speed: 200RPM 

• Rated Speed: 140RPM 

• Rated torque: 10kg.cm 

• Rated current: 2.5Amp 

• Length of Motor (including spindle): 106mm/4.17″ 

• Diameter: 37mm/1.45″ 

• Shaft length: 21mm/0.82″ 

• Shaft diameter: 6mm/0.24″ 
 

 

 

 

Figure 3.21: DC Gear Motor 

 
 

3.9 Conveyor Belt 

A conveyor belt is the carrying medium of a belt conveyor system (often shortened to 

belt conveyor). A belt conveyor system is one of many types of conveyor systems. A 

belt conveyor system consists of two or more pulleys (sometimes referred to as drums), 

with a closed loop of carrying medium—the conveyor belt—that rotates about them. 

One or both of the pulleys are powered, moving the belt and the material on the belt 

forward. The powered pulley is called the drive pulley while the powered pulley is 

called the idler pulley. 
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Overview 

Conveyors are durable and reliable components used in automated distribution and 

warehousing, as well as manufacturing and production facilities. In combination with 

computer-controlled  pallet  handling  equipment  this  allows  for  more 

efficient retail, wholesale, and manufacturing distribution. It is considered a labor- 

saving system that allows large volumes to move rapidly through a process, allowing 

companies to ship or receive higher volumes with smaller storage space and with less 

labor expense. 

 
 

Belt conveyors are the most commonly used powered conveyors because they are the 

most versatile and the least expensive. Products are conveyed directly on the belt so 

both regular and irregular shaped objects, large or small, light and heavy, can be 

transported successfully. Belt conveyors are also manufactured with curved sections 

that use tapered rollers and curved belting to convey products around a corner. 

These conveyor systems are commonly used in postal sorting offices and 

airport baggage handling systems. 

 

 
Application 

 

Today there are different types of conveyor belts that have been created for conveying 

different kinds of material available in PVC and rubber materials. Material flowing 

over the belt may be weighed in transit using a belt weigher. Belts with regularly 

spaced partitions, known as elevator belts, are used for transporting loose materials up 

steep inclines. Belt Conveyors are used in self-unloading bulk freighters and in live 

bottom trucks. Belt conveyor technology is also used in conveyor transport such 

as moving sidewalks or escalators, as well as on many manufacturing assembly lines. 

Stores often have conveyor belts at the check-out counter to move shopping items, and 

may use checkout dividers in this process. Ski areas also use conveyor belts to transport 

skiers up the hill. Industrial and manufacturing applications for belt conveyors include 

package handling, trough belt conveyors, trash handling, bag handling, coding 

conveyors, and more. Integration of Human-Machine Interface (HMI) to operate the 

conveyor system is in the developing stages and will prove to be an efficient innovation. 

https://en.wiktionary.org/wiki/distribution
https://en.wikipedia.org/wiki/Retail
https://en.wikipedia.org/wiki/Wholesale
https://en.wikipedia.org/wiki/Manufacturing
https://en.wikipedia.org/wiki/Distribution_(business)
https://en.wikipedia.org/wiki/Shipping
https://en.wikipedia.org/wiki/Expense
https://en.wikipedia.org/wiki/Conveyor_systems
https://en.wikipedia.org/wiki/Baggage_handling_system
https://en.wikipedia.org/wiki/Beltweigher
https://en.wikipedia.org/wiki/Conveyor_transport_(disambiguation)
https://en.wikipedia.org/wiki/Moving_sidewalk
https://en.wikipedia.org/wiki/Escalator
https://en.wikipedia.org/wiki/Assembly_line
https://en.wikipedia.org/wiki/Check-out_counter
https://en.wikipedia.org/wiki/Checkout_divider
https://en.wikipedia.org/wiki/Ski_resort
https://en.wikipedia.org/wiki/Magic_carpet_(ski_lift)
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Types of Conveyor Belt 

―There are three different types of conveyor belts: the basic belt, snake sandwich belt 

and long belt. A basic belt conveyor consists of two or more pulleys that hold one 

continuous length of material. These types of belts can be motorized or require manual 

effort. 

 

 

Figure 3.22: Conveyor Belt 

 
 

3.10 Pulley 

A pulley is a wheel on an axle or shaft that is designed to support movement and 

change of direction of a taut cable or belt, or transfer of power between the shaft and 

cable or belt. In the case of a pulley supported by a frame or shell that does not transfer 

power to a shaft, but is used to guide the cable or exert a force, the supporting shell is 

called a block, and the pulley may be called a sheave. A pulley may have a groove or 

grooves between flanges around its circumference to locate the cable or belt. The drive 

element of a pulley system can be a rope, cable, belt, or chain.[20] 
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Product Type Motor Pulley 

Size 5mm, 

Height 25mm 

Outer diameter 12.2mm/0.48 

Pitch Diameter 12.7mm/0.5 

 

 

 

 

Figure 3.23: Pulley [32] 

 
 

3.11 Arduino IDE 

The digital micro-controller unit named as Arduino Nano can be programmed with the 

Arduino software IDE. There is no any requirement for installing other software rather 

than Arduino. Firstly, Select "Arduino Nano from the Tools, Board menu (according to 

the micro-controller on our board). The IC used named as ATmega328 on the Arduino 

Nano comes pre burned with a boot loader that allows us to upload new code to it 

without the use of an external hardware programmer. Communication is using the 

original STK500 protocol (reference, C header files). We can also bypass the boot 

loader and programs the micro-controller through the ICSP (In Circuit Serial 

Programming) header. The ATmega16U2 (or 8U2 in the rev1 and rev2 boards) 

firmware source code is available. The ATmega16U2/8U2 is loaded with a DFU boot 

loader, which can be activated by: 
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On Rev1 boards: connecting the solder jumper on the back of the board (near the map 

of Italy) and then resetting the 8U2. On Rev2 or later boards: there is a resistor that 

pulling the 8U2/16U2 HWB line to ground, making it easier to put into DFU mode. 

The Arduino Nano is one of the latest digital micro-controller units and has a number 

of facilities for communicating with a computer, another Arduino, or other micro- 

controllers. The ATmega328 provides UART TTL at (5V) with serial communication, 

which is available on digital pins 0 -(RX) for receive the data and pin no.1 (TX) for 

transmit the data. An ATmega16U2 on the board channels this serial communication 

over USB and appears as a virtual com port to software on the computer. The '16U2 

firmware uses the standard USB COM drivers, and no external driver is needed. 

However, on Windows, an .in file is required. The Arduino software includes a serial 

monitor which allows simple textual data to be sent to and from the Arduino board. 

The RX and TX LEDs on the board will flash when data is being transmitted via the 

USB-to-serial chip and USB connection to the computer (but not for serial 

Communication on pins 0 and 1). A Software Serial library allows for serial 

communication on any of the Nano's digital pins. The ATmega328 also supports I2C 

(TWI) and SPI communication. The Arduino software includes a Wire library to 

simplify use of the I2C bus. Arduino programs are written in C or C++ and the program 

code written for Arduino is called sketch. The Arduino IDE uses the GNU tool chain 

and AVR Lab to compile programs, and for uploading the programs it uses argued. As 

the Arduino platform uses Atmel micro-controllers, Atmel's development environment, 

AVR Studio or the newer Atmel Studio, may also be used to develop software for the 

Arduino. 



38  

 
 

Figure 3.24: Arduino IDE Interface 

 

 
Writing Sketches 

Programs written using Arduino Software (IDE) are called sketches. These sketches are 

written in the text editor and are saved with the file extension. The editor has features 

for cutting/pasting and for searching/replacing text. The message area gives feedback 

while saving and exporting and also displays errors. The console displays text output by 

the Arduino Software (IDE), including complete error messages and other information. 

The bottom righthand corner of the window displays the configured board and serial 

port. The toolbar buttons allow you to verify and upload programs, create, open, and 

save sketches, and open the serial monitor. 

Sketch book The Arduino Software (IDE) uses the concept of a sketchbook: a standard 

place to store your programs (or sketches). The sketches in your sketchbook can be 

opened from the File > Sketchbook menu or from the Open button on the toolbar. The 

first time you run the Arduino software, it will automatically create a directory for your 

sketchbook. You can view or change the location of the sketchbook location from with 

the Preferences dialog. Beginning with version 1.0, files are saved with a .ino file 

extension. Previous versions use the. pde extension. You may still open. pde named 

files in version 1.0 and later, the software will automatically rename the extension 

to.ino. 
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Tabs, Multiple Files, and Compilation 

 
Allows you to manage sketches with more than one file (each of which appears in its 

own tab). These can be normal Arduino code files (no visible extension), C files (.c 

extension), C++ files (.cpp), or header files (.h). 

Uploading 

 
Before uploading your sketch, you need to select the correct items from the Tools > 

Board and Tools > Port menus. The boards are described below. On the Mac, the serial 

port is probably something like /dev/tty. usbmodem241 (for an Uno or Mega2560 or 

Leonardo) or /dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or 

/dev/tty. USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to- 

Serial adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or 

COM4, COM5, COM7, or higher (for a USB board) - to find out, you look for USB 

serial device in the ports section of the Windows Device Manager. On Linux, it should 

be /dev/ttyACMx , /dev/tty USBx or similar. Once you've selected the correct serial 

port and board, press the upload button in the toolbar or select the Upload item from 

the Sketch menu. Current Arduino boards will reset automatically and begin the 

upload. With older boards (pre-Diecimila) that lack auto-reset, you'll need to press the 

reset button on the board just before starting the upload. On most boards, you'll see the 

RX and TX LEDs blink as the sketch is uploaded. The Arduino Software (IDE) will 

display a message when the upload is complete, or show an error. 

 
 

When you upload a sketch, you're using the Arduino boot-loader, a small program that 

has been loaded on to the micro-controller on your board. It allows you to upload code 

without using any additional hardware. The boot-loader is active for a few seconds 

when the board resets; then it starts whichever sketch was most recently uploaded to 

the micro-controller. The boot-loader will blink the on-board (pin 13) LED when it 

starts (i.e. when the board resets). 

Libraries 

 
Libraries provide extra functionality for use in sketches, e.g. working with hardware or 

manipulating data. To use a library in a sketch, select it from the Sketch > Import 

Library menu. This will insert one or more #include statements at the top of the sketch 
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and compile the library with your sketch. Because libraries are uploaded to the board 

with your sketch, they increase the amount of space it takes up. If a sketch no longer 

needs a library, simply delete its #include statements from the top of your code. There 

is a list of libraries in the reference. Some libraries are included with the Arduino 

software. Others can be downloaded from a variety of sources or through the Library 

Manager. Starting with version 1.0.5 of the IDE, you do can import a library from a zip 

file and use it in an open sketch. See these instructions for installing a third-party 

library. 

 
Third-Party Hardware 

Support for third-party hardware can be added to the hardware directory of your 

sketchbook directory. Platforms installed there may include board definitions (which 

appear in the board menu), core libraries, boot loaders, and programmer definitions. To 

install, create the hardware directory, then unzip the third-party platform into its own 

sub-directory. (Don't use "Arduino" as the sub-directory name or you'll override the 

built-in Arduino platform.) To uninstall, simply delete its directory. For details on 

creating packages for third-party hardware, see the Arduino IDE 1.5 3rd party 

Hardware specification. 

 
Serial Monitor 

This displays serial sent from the Arduino or Genuine board over USB or serial 

connector. To send data to the board, enter text and click on the "send" button or press 

enter. Choose the baud rate from the drop-down menu that matches the rate passed to 

Serial begin in your sketch. Note that on Windows, Mac or Linux the board will reset 

(it will rerun your sketch) when you connect with the serial monitor. Please note that 

the Serial Monitor does not process control characters; if your sketch needs a complete 

management of the serial communication with control characters, you can use an 

external terminal program and connect it to the COM port assigned to your Arduino 

board. 
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3.12 Easy EDA Software 

Easy EDA is a web-based EDA tool suite that enables hardware engineers to design, 

simulate, share - publicly and privately-and discuss schematics, simulations and printed 

circuit boards. Other features include the creation of a bill of materials, Gerber files and 

pick and place files and documentary outputs in PDF, PNG and SVG formats. Easy 

EDA allows the creation and editing of schematic diagrams, SPICE simulation of 

mixed analogue and digital circuits and the creation and editing of printed circuit board 

layouts and, optionally, the manufacture of printed circuit boards. 

 
Subscription-free membership is offered for public plus a limited number of private 

projects. The number of private projects can be increased by contributing high quality 

public projects, schematic symbols, and PCB footprints and/or by paying a monthly 

subscription. Registered users can download Gerber files from the tool free of charge; 

but for a fee, EasyEDA offers a PCB fabrication service. This service is also able to 

accept Gerber file inputs from third party tools. 

 
 

 

Figure 3.25: Easy EDA Software Interface 
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Chapter 4 

Model Setup and Procedure 

 
4.1 Introduction 

In this chapter we describe our project block diagram, circuit diagram, project working 

principle and final project view. 

 

4.2 Block Diagram 

In our project we have set up a Fabrication of Belt Type Oil Skimmer. Here, in this 

system, we are use AC source and DC (Battery) Source for operate. Here we also use a 

transformer, gear motor, solar panel, battery, load cell, LCD Display, charge controller, 

pully etc. 

 

 
 

Figure 4.1: Block Diagram of Fabrication of Belt Type Oil Skimmer System. 
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4.3 Circuit Diagram of proposed Model 
 

 

 

 

 

 

Figure 4.2: Circuit Design Fabrication of Belt Type Oil Skimmer System. 

 
 

4.4 Components Rating and Quantity 

 
Table 01: Component’s Name and Price 

 

Sl. No Components Name Specification Quantity Unit Price Total Price 

01 SMPS  1 580 580 

02 Arduino Nano ATmega328 1 680 680 

03 Load Cell 5-10V 1 690 690 

04 Transformer 12V, 3Amp 1 280 280 

05 Gear Motor 12V, 100 RPM 1 880 880 

06 Solar Panel 12V. 6 Watt 1 950 950 

07 Battery 12V, 4.7Amp 1 1250 1250 

08 Solar Charge Controller 12V 1 350 350 

09 Metallic Structure  1 1350 1350 

10 Others    1550 

Total 6,610/= 
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4.5 Working Principle 

Here we use a solar panel for power generating elements and restore it in a battery for 

battery charge controller. In this project Solar takes sunlight and produces some energy 

and stores it battery with the help of a charge controller system. We are use some 

equipment's like Arduino, SMPS, Load Cell, Gear Motor, Battery, LCD Display, solar 

Charge Controller. This solar cell is controlled by the Micro-controller. When the 

power up of this system then the system able to work. Then if we start the system then 

transformer rectifier the AC current and rotate the gear motor. This gear motor is able 

to control its speed. When we need to oil skimming then just place the system on this 

water and start our project. Our System will be separate oil from the water easily and 

load cell measure the amount of oil. This is the main procedure of our system. 

 
 

4.6 Basic Drawing of System 
 

 
Figure 4.3: Basic Drawing of this System 
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4.7 Real View of project 
 

 
Figure 4.4: Our Project Prototype (Front View) 

 

 

 

 

Figure 4.5: Our Project Prototype (Top View) 
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4.8 PCB Design: 

The PCB Layout module is automatically given connectivity information in the form of a 

net list from the schematic capture module. It applies this information, together with the 

user specified design rules and various design automation tools, to assist with error free 

board design. PCB's of up to 16 copper layers can be produced with design size limited by 

product configuration. 

 
 

 

Figure 4.6: PCB Design 

 
4.9 3D Verification: 

The 3D Viewer module allows the board under development to be viewed in 3D together 

with a semi-transparent height plane that represents the board’s enclosure. STEP output 

can then be used to transfer to mechanical CAD software such as Solid works or Auto 

desk for accurate mounting and positioning of the board. 

 

 
Figure 4.7: 3D Verification. 
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Chapter 5 

Results and Discussions 

 
5.1 Result 

After making our project we observe it very careful. It works as we desire. Our project 

give output perfectly and all equipment are work perfectly. We check how much it works 

and we get perfect output from this project. 

 Finally, we have completed our project successfully & check our project its run 

accurately according to our objective. 

 At first, we start our system. 

 At first, we connect the AC 220 to system on. 

 Then we start the switch then motor will be rotate. 

 Then belt will separate the oil from water. 

 And load cell measures the amount of oil. 

 Then oil will be store in a jar. 

 Oil amount of measure show in LCD Display. 

 
 

SL. Belt Type Time Collect Oil 

1. Basic Belt 1 Min 120 ml 

2 Min 230 ml 

3 Min 330 ml 

2. Snake Sandwich 1 Min 200 ml 

2 Min 380 ml 

3 Min 450 ml 

3. Long Belt 1 Min 300 ml 

2 Min 380 ml 

3 Min 460 ml 
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5.2 Application 

The application areas for this project in this modern and practical world are huge and 

some of these are given below: 

 

 It can be implemented in sea. 

 Industry 

 On Ship 

 Factory 

 

5.3 Discussion 

While working on our project, we did face some difficulties as it is a very complex 

system but the end results, we came up with were quite satisfactory. We have put the 

whole system through several tasks to validate our work and also have taken necessary 

notes for future improvements. Some future recommendations that we have involves 

improvement in system design and wiring, adding features for more efficient. 
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Chapter 6 

Conclusion and Future Scope 

 
6.1 Conclusion 

In this project, we enforced to highlight the function of oil skimmer, its various design 

aspects and performance. All the results of experimental studies indicate that slight 

design improvement of typical oil skimmers towards to include additional belt shaft 

and use of belt with steel material instead of rope; significantly improve the oil 

recovery efficiency and also its structure became simpler. Further extensive research & 

testing can improve the existing techniques and equipment to have better control for oil 

recovery exercise. 

 

6.2 Future Work 

We are thinking about adding many features to our project in the future to get more 

desirable out comes. Some of the steps that we are thinking about taking are given 

below: 

 

• In future we will add some sensor to measure oil quantity in container. 

• In future we will add IoT System to operate in fully automatically. 

• In future we will add protection equipment to protect this system from any kind 

of hazard. 
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https://www.google.com/search?q=solar+panel&tbm=isch&ved=2ahUKE
https://www.google.com/search?q=solar+charge+controller&tbm
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[13] https://www.google.com/search?q=transistor&tbm=isch&ved 

 

[14] https://www.google.com/search?q=transformer&tbm=isch&ved 

 

[15] https://www.google.com/search?q=battery+12+volt&tbm=isch&ved 

 

[16] https://www.google.com/search?q=dc+gear+motor&tbm=isch&ved 

 

[17] https://www.google.com/search?q=conveyor+belt&tbm=isch&ved=2ahUKEwi

 ykenhiL 

 

[18] https://www.google.com/search?q=pully&tbm=isch&ved=2ahUKEwit_tvviLm 

 

[19] https://www.google.com/search?q=arduino+ide&tbm=isch&ved=2ahUK 

 

[20] https://www.google.com/search?q=easyeda&tbm=isch&ved=2ahUKEwiUpNSf

 ibmBAxXhb2wGHZOWBIAQ2-cCegQIABAA&oq 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.google.com/search?q=transistor&tbm=isch&ved
https://www.google.com/search?q=transformer&tbm=isch&ved
https://www.google.com/search?q=battery+12+volt&tbm=isch&ved
https://www.google.com/search?q=dc+gear+motor&tbm=isch&ved
https://www.google.com/search?q=conveyor+belt&tbm=isch&ved=2ahUKEwi
https://www.google.com/search?q=conveyor+belt&tbm=isch&ved=2ahUKEwi
https://www.google.com/search?q=pully&tbm=isch&ved=2ahUKEwit_tvviLm
https://www.google.com/search?q=arduino+ide&tbm=isch&ved=2ahUK
https://www.google.com/search?q=easyeda&tbm=isch&ved=2ahUKEwiUpNSf
https://www.google.com/search?q=easyeda&tbm=isch&ved=2ahUKEwiUpNSf
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APPENDIX 
 

Programming Code: 

 

#include <LiquidCrystal_I2C.h>   // scl=d1& sda=d2 

LiquidCrystal_I2C lcd(0x27, 16, 2);  // I2C address 0x3F, 16 column and 2 rows 

#include <HX711_ADC.h> // need to install  

#include <Wire.h> 

HX711_ADC LoadCell(6, 7); // parameters: dt pin 6, sck pin 7; 

 

void setup() { 

  // put your setup code here, to run once: 

Serial.begin(115200); 

 

 LoadCell.begin(); // start connection to HX711 

  LoadCell.start(2000); // load cells gets 2000ms of time to stabilize 

  LoadCell.setCalFactor(1000.0); // calibration factor for load cell => dependent on your individual 

setup 

  lcd.init();  

  lcd.backlight(); 

  

  lcd.begin(16,2); 

  lcd.init();      // initialize the lcd 

  lcd.backlight(); // open the backlight  

} 

void loop() { 

  // put your main code here, to run repeatedly: 

  LoadCell.update(); // retrieves data from the load cell 

  float i = LoadCell.getData(); // get output value 

  float weight=((i/1000)*3)/2.16; 

  lcd.setCursor(0, 1); // set cursor to first row 

  lcd.print("Weight: "); // print out to LCD 

  lcd.print(weight); // print out the retrieved value to the second row 

} 

[1]  


